PIVOT TABLE 101
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WHY PIVOT TABLES?

W00~ o s W
N N ) S N ) B

A B C D
State - Year ~ Total Population ~ Student Population ~
New Mexico 2002 1,903,289 310,117
Nebraska 2003 1,826,341 313,968
Maryland 2004 5,884,563 359,210
California 2003 37,253,956 8,965,848
Meontana 2002 926,865 163,067
D.C. 2004 917,092 183,811
Alaska 2002 655,435 153,920
Minnesota 2001 4,019,479 1,195,975
Louisiana 2001 4,468,976 626,279
Montana 2001 902,195 208,952
| New Mexico 2004 2,085,538 631,320
West Virginia 2004 1,855,413 244,566
Louisiana 2004 4,601,893 326,680
Arizona 2003 6,329,013 1,837,525
Maryland 2001 5,296,486 1,399,408
Tennessee 2002 5,900,962 595,648
Texas 2002 23,764,231 5,246,483
Rhode Island 2003 1,052,567 173,937
Utah 2001 2,233,169 388,385
Wisconsin 2001 5,363,675 1,415,261
Kansas 2004 2,885,905 872,769
D.C. 2001 783,600 166,161
California 2002 35,893,799 3,598,863
Ohio 2003 11,536,502 3,361,193
Texas 2003 25,145,561 7,561,350
Alabama 2002 4,530,182 1,273,375
Utah 2002 2,389,039 460,374
Virginia 2003 8,001,024 1,445,224

Looking at a raw data set like the one here,
how would you answer the following?
Which state had the highest population in 2002?
In which year was overall US population the highest?

Which states saw a decline in student population rate
between 2003 and 2004?

What if you don’t even know what
you're looking for?



A

1 State b
2 | New Mexico
= Nebraska
4 Maryland

5 California
& Montana

7 D.C.

8 Alaska

9 Minnesota
10 Louisiana
11 Montana
12| New Mexico
13| West Virginia
14 Louisiana
15 Arizona
16 Maryland
17 Tennessee
18 Texas

19 | Rhode Island
20 Utah
21 Wisconsin
22 Kansas
23 n.C.
24| California
25 Ohio
26 Texas
27|  Alabama
28 Utah
29 Virginia

*Quote not confirmed

Year
2002
2003
2004
2003
2002
2004
2002
2001
2001
2001
2004
2004
2004
2003
2001
2002
2002
2003
2001
2001
2004

2002
2003
2003
2002
2002
2003

C
Total Population ~
1,803,289
1,826,341
5,884,563
37,253,956
026,865
917,002
655,435
4,919,479
4,468,976
902,195
2,085,538
1,855,413
4,601,893
6,320,013
5,206,486
5,900,962
73,764,231
1,052,567
2,233,169
5,363,675
2,885,905
783,600
35,803,799
11,536,502
25,145,561
4,530,182
2,389,030
8,001,024

D
Student Population -
310,117
313,968
359,210
8,965,848
163,067
183,811
153,920
1,195,975
626,279
208,952
631,320
244,566
326,680
1,837,525
1,399,498
595,648
5,246,483
173,937
388,385
1,415,261
H72,769
166,161
3,508,863
3,351,103
7,561,350
1,273,375
460,374
1,445,224

PIVOT TABLE 101

PivotTables allow you to easily organize, filter,

summarize, and analyze raw data

“Analyzing data without a Pivot is like hammering a nail with a noodle”

H -

File Home

7 B

PivotTable|Recommended Table
PivotTables
Tables

-Albert Einstein*

A | B | C | D | E |

1] State | - Year -~ Total Pop % of State Pop Student Population %
2 | ZAlabama 18,579,040 100.00% 19.15%
3 | 2001 4,447,100 23.94% 21.33%
4 | 2002 4,530,182 24.38% 28.11%
5 | 2003 4,779,735 25.73% 10.39%
6 | 2004 4,822,023 25.95% 17.42%
7 | = Alaska 2,724,047 100.00% 12.99%
8 | 2001 626,932 23.01% 10.72%
9 | 2002 655,435 24.06% 23.48%
10 | 2003 710,231 26.07% 7.75%
11_ 2004 731,449 26.85% 10.63%
12_ = Arizona 23,756,734 100.00% 17.32%
13 | 2001 5,130,632 21.60% 27.22%
14 | 2002 5,743,834 24.18% 6.10%
15_ 2003 6,329,013 26.64% 29.03%
16_ 2004 6,553,255 27.58% 8.09%
EXCEL
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KEY BENEFITS

POWERFUL

- Uncover insights and answer key questions about your data

BEAUTIFUL

- Apply custom styles and conditional formatting rules to bring your Pivots to life

FAST

- Create custom views, filters, and calculated fields on the fly

ACCURATE

- Automate calculations to minimize human error

FLEXIBLE

- Manipulate table layouts and create dynamic views in seconds



DATA STRUCTURE

E F G [ I 1 A B D E F G H 1
Gender Fight Date Destination City Destination State Type of Travel Class 1
Male #14/0ma Dallas/Foet Worth, X Texas Bmness trave! Busness " NG DATA

A B
1 | Satisfaction  Airine Status
2z s Bue
3 4 Blue " 5059 Male M1L2004  Dallas/Fort Worth, T Texas B travel Business 1
4 3 Bue 7 2020 Female 125/2014  Dallsa/Fes Wank, TX Toxas Porsenal Travel Business
5 4 ™ a3 4040 Male HANI0NE  DisdlanFoet Wtk T Torm Rstinmis travel Fea
3 5 Sitver E 4048 Male: IS4 DeilasfFort Worth, TX Texas Buaness travel Eco 2 Period1 - | Period2 - Period3 - Periodd - PeriodS - Periodf - Period? - Periods =
7 5 Gokd L] 48 female Y16/2014  Dalles/Fout Worth, TX Texas Basiness travel Eco 3 Impressions 1,286,982 2,873,987 1,266,721 1,236,237 2,122,113 2,145,532 2,516,782 2,081,727
(] 3 Gold ] 3030 Male 36/2014  Dallas/Fort Worth, T Toxas Business travel Eca ot —— — - : . .
] 4 Siver EE] 3039 Male S04 Dalas/Fodt Warth, TX Tewas fursiness travel Feo 4 Clicks 627 374 827 263 912 662 723 1283
w0 4 e £ 4049 temale A VataslFor wortn, 1% Tesa tsiness travel Eco 5 cTR 0.049% 0.013% 0.065% 0.021% 0.043% 0.031% 0.029% 0.043%
1 4 Blue 51 059 Female 1/19/2004  Dallan/Font Worth, T Teaa Busimss travel Eco S
4 e m 220 Mals 3/19/2014  Dallsa/Fort Worh, TX Tonas stirss travel Ko (] Calumn3 79 67 0 88 66 79 95 85
2 Bhue ) 330 Female Hefaria Disflaa/Foet Wiarth, TX Texas Bistiness fravel Een 7 Calumnd 20 6 20 15 12 15 18 17
5 #latioum a0 a4y temale 115/2014  Dallas/Fort Wortk, 1X Texay s trave ko v
3 Siber 2 2029 Female  2/5/2018  Dales/Fort Worth, TX Teras Business travel ko 8 CvR 25% 9% #oIv/ol 7% 18% 19% 19% 20%
2 = 52 550 femals 3/13/2014  Duallas/Fort Worth, TX Texas Mileage fickts Eco ]
3 Blue &% a4 Male US/2014 DuallasFost Worth, TX Texas Mileage tickets Eco
3 Slhver [+ o9 Female Ve/in4  DallasiFort Worth, TX Texas Personal Travel Eco 10 Monthly Costs
2 Blus M 2029 Female 2/9/2004  Dallas/Fort Warth, TX Tesas Persomal Travel Eeo 11 Jan 5395
1 [ ] 7079 Femnala WEI0I4 Dallaa/For Wank, TX Toxat Parscnal Travel Feo 12 Feb $350
3 Blue 19 019 Femnale /162014 Disllas/Fort Worth, TX Texas Personal Travel Eco 3 M 206
3 Blue 8 339 female Y19/2014  Dallas/Fort Wonh, TX Texas persanal Travel Eco 1 L8 5206
2 e 62 6068 Male 124/2014  Dalles/Fort Worth, TX Texas Personal Travel Eco 14 Apr 5214
i 11542 fat | T
3 Blue 16 019 Male 1152014 Dallas/Fort Worth, T Texas Persanal Travel Eco 15 Moy 5385
1 Blue &7 465 female /2014 Dallas/Fort Worth, T Texas Personal Travel Eco
2 Biue a 2049 female 322014 Dallas/For Worth, T Texas Personal Travel Eco 16 dun 5301
3 e ] 6069 femals VL2014 Dollas/Toet Warth, TX Texas Persenal Travel feo 17 Jul 5263

. Rectangular (variables as columns, observations as rows) . Transposed (variables as rows, observations as columns)
. No extra formatting . Unnecessary formatting

. Contains only dimensions & measures . Contains calculated fields

. Clear column headers . Confusing column header names

. No extra headers, footers, sub-totals or calculated fields . Extra header rows




INSERTING A PIVOT TABLE

=R

File

’ o From the “Insert” menu, select PivotTable to create a blank

i Pivot, or use the Recommended PivotTables option to
2 L LoD g 2o . . P
PivotTable Recommended [Table Pictures Online browse pre'populated Startlng pOlntS

PivotTables Pictures @+ Screenshot
Tables 1lustrations

Formulas Data

Sum of IMDb Score (1-10.. = Sum of IMDb Score (1-10) by Country
m:::: <ozl P beem LS Row Labels - Sum of IMDb Score (1-10)
e o Afghanistan 7.4
Create PivotTable B X | . #22 ||=| Argentina 22.8
Brad s Aruba 4.8

Choose the data that you want to analyze = {::‘:4“ “1‘3 Australia 252.2

(@) select a table or range Sum of Lead Actor FB Li.. Belgium 13.4
: o5 Row Labels - Sum of Lead Actor F8 Likes Brazil 38.8
 TeblefRenge: | = What data are e T 2019
() Use an external data source i A 19 )
o nalyzing? o i ;
e you analyzing o wr |1} Chile 6.9
Choose Connectio B 31324 China 98.2
— Beasil 250 )
Connection name: / Canada 230025 Colembia 7.5
Use this workbook's Data Model -~ e " Czech Republic 20.9
Sum of Movie FB Likes, ...

Choose where you want the PivotTable report to be placed R T R Denmark 65.1
. i : Finland 7.2
© New Worksheet Where will the epenis France 705.2
a e . . Arubs an b
O EEpEEEE PivotTable live? s s Georgia 5.6

Location: | Sheet2!$A351 rasl Fra] Germany 497.6
Canada 246425
Thoose whether you want to anaEe muﬁrp!e tables - e v Hong Kong 89.5
(1- Hungar 12.9
|:| Add this data to the Data Model Sum of IMDb Score (1-10.. gary
Row isbels - Sum of IMDb Score (1-10) Iceland 13.8

[ ][ Sasiem %83 T india ar kA

OK Cancel change Source Data...

(Insert = PivotTable) (Insert 2 Recommended PivotTables) EXCEL
|z
]

MAVEN




THE FIELD LIST

The Field List shows all the
variables in your dataset, and
which ones are currently
included in the Pivot

If there are fields that you want
to use to filter the whole data

set, drag them to the Filters box

Variables included in the Rows
field will appear as individual
rows within the Pivot

PivotTable Fields

Choose fields to add to report:

Search

- X

s -y Layout options allow you to adjust

0

the look and feel of the field list

[V] state

V| Year

| Total Population
Student Population

More Tables...

Variables included in the Columns

Drag fields between areas below:

T Filters

Year

Il Columns
M|

field appear as individual columns

|_~" within the Pivot

= Rows

State

2 Values

| Sum of Total Population ~

Numerical variables are almost always
included in the Values field

(These are the quantitative measures that you

care about: sales, revenue, clicks, etc.)



ANALYZE & DESIGN OPTIONS

The “Analyze” Tab:

Hd ©- MAP_Excel_Training_E PivotTable Tools opher Dutton
File Home Insert Page Layout Formulas Data Review View Developer  Analytics Edge Power Pivot Analyze Design Q Tell me what you want to do ,Qr Share
PivotTable Name: Active Field: = . = Group Selection | r_ =
*= Expand Field - 2 'Y I:[:I_’ (-7' (J‘% < fx 9 E E‘E E
PivotTable2 Year % Ungroup = =~ & [1 ] ] f , 7
- - - Dri Dri -= Collapse Field [ . Insert Insert Filter Refresh Change Data Clear Select Move Fields, Items, O Relationships | PivotChart Recommended | Field +/- Field
’:éOptlons - [g Field Settings pown Up - Group Field Slicer Timeline Connections = Source ~ = - PivotTable  &Sets~ Tools PivotTables List Buttons Headers
PivotTable Active Field Group Filter Data Actions Calculations Tools Show ~

The “Design” Tab:
E ) el_Training_B»

File Home Insert Page Layout Formulas [BEE] Review View Developer Analytics Edge Power Pivot

+| Row Headers Banded Rows

Subtotals Grand  Report Blank | [] coluymn Headers [ | Banded Columns =
< Totals ~ Layout ~ Rows ~

Tell me what you want to do

Layout PivotTable Style Options PivotTable Styles




SELECTING, CLEARING & MOVING PIVOTS

H -

File Home Insert Page Layout Formulas Data Review View

PivotTable Name: Active Field: *Z Bpand Field

PivotTable2 Year &5 Ungroup

Dril Dri -= A .
[Zoptions - [RFieldSettings poyn Up-  — 0 2P el I Group Field
PivotTable Active Field Group
X Clear Al
Clear Filters

Clear options allow you to
clear all fields and values
from atable, or just any filters
that have been applied

MAP_Excel_Training_Exercises - Exce

= Group Selection

PivotTable Tools

Developer Analytics Edge Power Pivot Analyze Design

"7;" Tell me what you want to do

Christopher Dutton

,Q;. Share

= . L] e +
Eile L& ig %, i3 [ Dy O iy O ERECRE
Insert Insert Filter Refresh Change Datajl Clear Select Move Fields, Items, OLAP Relationships | PivotChart Recommended | Field +/- Field
Slicer Timeline Connections - Source ~ PivotTable & Sets~  Tools PivotTables List Buttons Headers
Filter Data Actions Calculations Tools Show ~

E Labels and Values
E Values

E Labels

Entire PivotTable

B Enable Selection

Select options (allow you to select
entire sections of the PivotTable
(or the entire table itself)

Choose where you want the PivotTable report to be placed

() New Worksheet

‘-‘é" Existing Worksheet

Location: | Sheetl!A7

Select =2 Entire PivotTable, then copy
and paste to duplicate an entire Pivot

Move options allow you to
relocate an existing PivotTable to
anew worksheet or a new location
within the existing one



REFRESHING & UPDATING PIVOTS

H - = MAP_Excel Training_Exercises - Exce PivotTable Tools Christopher Dutton

File Home Insert Page Layout Formulas Data Review View Developer Analytics Edge Power Pivot Analyze Design ‘.;‘ Tell me what you want to do er Share

PivotTable Name: Active Field: = . =2 Group Selection | . n = E\
= Expand Field - E' ~ K &) <, f x :?
PivotTable2 Year &5 Ungroup Y Y B L \' % - ) X 24 I H C E :
- - - Dri Dri -= Collapse Field [ . Insert Insert Filter Refresh Change Data | Clear Select Move Fields, Items, OLAP Relationships | PivotChart Recommended | Field +/- Field
lizOptions - g Field Settings pown Up n Group Field Slicer Timeline Connectiong = Source - = - PivotTable  &Sets- Tools PivotTables List Buttons Headers
PivotTable Active Field Group Filter Data Actions Calculations Tools Show ~

Change PivotTable Data So:m:e — —— @ I = ‘
Refresh updates the PivotTable based chogee e daa bt e et saies

(@) select a table or range

On Changes made W|th|n the deﬂned Table/Range: | 'Product Sales'!$A$1:5P§3399
source data range or table

Connection name:

\ J

' ¥
Ay

Format your source data as a table to dynamically Change Data Source allows you
adjust as new columns or rows are added, or use

acolumn-only range reference (i.e. $A:$G) refresh the Pivot to reflect changes

outside of the defined source range
or table (i.e. new columns or rows)



HOW DO PIVOTS ACTUALLY WORK?

—
A | B | .
T~ | .
1 [ (A1) -1 ~ STEP 1: Detect/evaluate coordinates
2
3 |State 'I] Average of Total Population I ° State = Arizona A B c (
4 |Alabama 719 —- . 1 |State - IAge - IT::tal Population - ‘Tntal Citizen |
t | alaska 103 ° Measure = Total POpU lation 2 |Alabama 1810 24 439 428
- ° i - 3 |Alabama 25to 34 576 535
6 |Arizona I 973 Filter = All ages 4 |Alabama 351044 615 582
7 |Arkansas 440 5 |Alabama 4510 64 1297 1275
8 |california 5672 6 |Alabama 65+ 667 660
— ! 7 |Alaska 18t0 24 63 61
9 |Colorado 763 8 |Alaska 251034 109 103
10 |Connecticut 545 9 |Alaska 35t0 44 86 80
117 Delaware 139 10 |Alaska 45 to 64 186 182
Excel isolates relevant source data 11 |Alaska 65+ Z2 69
_J 12 |Arizona 18to 24 586 545
13 | Arizona 25 to 34 859 709
14 | Arizona 35t0 44 870 713
15 |Arizona 45 to 64 1656 1502
. . 16 |Arizona 65+ 892 846
" 17 |Arkansas 18to 24 288 281
STEP 2' Apply arlthmetlc 18 | Arkansas 251034 362 336
. Summarize Values By: AVERAGE
. (vs. SUM, COUNT, MAX, MIN, etc.) al . : \
1 Age (Al >
2 | NOTE: You can double-click any
A Bl Stale = [BverspsofiotallRoputation specific value in a Pivot to generate
STEP 3: Dis P | ay resu It 4 _|Alabama 719 anew tab showing the exact source
3 |Alaska 103 data used to calculate it
. (586+859+870+1656+892)/5 = 973 6 |Arizona 973
7 |Arkansas 440




PIVOT FORMATTING




NUMBER FORMATTING

1

1 Format Cells...

[ romwe: ot EEETN )
A Mumber || alignment | Font ] Border | Fill | Protection | -
r.:_\, Refresh
Gategory: -
[ - | sl
Sort | hourntaes s
Currency
x Remove "Sum of Tatal POpUIatiOn“ Accourting General farmat cells have no specific number format.
Date
- Tume
- Percentage
Summarize Values By Fraction
Seientific
Text
Show Values As special
Custom
*= Show Details

L_é Value Field Settings...
PivotTable Options...

Hide Field List

Y INIIRTIQ

Right-click a column header or any individual value within

afield to change the number format (number, currency,
percentage, date, etc.)

Right click, select PivotTable Options, and select
the “Layout & Format” tab to customize how you
want to display blank or error values

[x: MAVEN



TABLE STYLES

H - Excel_PivotTable_Exercises WIP_v2 - Excel Pivo

File Home Insert Page Layout Formulas Data Review View Developer Analytics Edge Power Pivot Analyze Design

Select from arange of styles
(right-click to make default), or

v| Row Headers v| Banded Rows

Subtotals Grand Report Blank
= Totals - Layout ~ Rows =

| Column Headers Banded Columns

Layout PivotTable Style Options C u Sto m i Ze yo u r OW n :
A3 - Jfr | state
A | B | €

1 Age (Al - o——— R
3 3 New PivotTable Sq.le . 2
3 State - | Average of Total Population bame: | PreofTable Style 2 |
4 | Alabama 719 | e et |
5 |Alaska 103 || Fepeet e abes -
6 | Arizona 973 Report Fiter Values =

i First Cobamn Strpe
7 B Arkansas 440 Second Column Stripe
8 | California 5,672 ?:L::“R::';’:w
9 Colorado 763 Farst Cobamn
1()7 Connecticut 545 Bedienow = = -

| | Eormat
11 Delaware 139 . =
12  District Of Columbia 103 Flement Formatting:
13 Florida 3,007
14 Georgia 1,436 =—==== ===== =====
15 |Hawaii 202 e ———
157 Idaho 226 e reeaa Set as default PivofTable style for this document
17 illinois 1,930 oc || cancel |
18 Indiana 971
19 lowa 464
20 Kansas 424
21 Kentucky 658
22 | Louisiana 664 | | New PivotTable Style...
23 Maine 208 T8 Cleor
24 Maryland 890




TABLE LAYOUTS: COMPACT VS. OUTLINE

Compact Form (default): Outline Form (recommended):

(R R T RN RV
|

A B A B @ D
_|Order Priority (Al v 1 |Order Priority (All) A
Region (All) - 2 |Region (All) ~
| 3
} Row Labels ¥ Sum of Order Quantity 4 : Product Category | ~ | Product Sub-Category -7 Product Name IT| Sum of Order Quantity
i =/Furniture 4,563 5 | = Furniture 4,563
= Bookcases 1,347 6 | =/Bookcases 1,347
0'sullivan 3-Shelf Heavy-Duty Bookcases 500 7 | O'sullivan 3-Shelf Heavy-Duty Bookcases 500
] Bush Mission Pointe Library 442 8 Bush Mission Pointe Library 442
| 0'sullivan Elevations Bookcase, Cherry Finish 405 9| 0O'Sullivan Elevations Bookcase, Cherry Finish 405
= Chairs & Chairmats 1,674 10| =IChairs & Chairmats 1,674
| Global High-Back Leather Tilter, Burgundy 666 11 | Global High-Back Leather Tilter, Burgundy 666
| Global Troy™ Executive Leather Low-Back Tilter 550 12 Global Troy™ Executive Leather Low-Back Tilter 550
| Office Star - Mid Back Dual function Ergonomic High Back Chair 458 13 Office Star - Mid Back Dual function Ergonomic High 458
| =Tables 1,542 14 =Tables 1,542
Bevis 36 x 72 Conference Tables 619 15| Bevis 36 x 72 Conference Tables 619
BoxOffice By Design Rectangular and Half-Moon Meeting Room 516 ol BoxOffice By Design Rectangular and Half-Moon Me 516
| Bretford CR8500 Series Meeting Room Furniture 407 17| Bretford CR8500 Series Meeting Room Furniture 407
. = Office Supplies 2,137 18 = Office Supplies 4,137
. = Binders and Binder Accessories 1,400 19| = Binders and BindErAccessuriE:: ] ] . ] . 1,400
Wilson Jones Hanging View Binder, White, 1" 585 v Wilson Janes Hanging View Blnd.er, White, 1 o8
m . . 21 Storex DuraTech Recycled Plastic Frosted Binders 412
Storex DuraTech Recycled Plastic Frosted Binders 412 . ! .
. Avery Flip-Chart Easel Binder, Black 203 22 Avery Flip-Chart Easel Binder, Black 403
~ 23 = Paper 1,379
=Paper . . . ) 1,379 24| Computer Printout Paper with Letter-Trim Perforatic 502
Computer Printout Paper with Letter-Trim Perforations 502 25’ Xerox 210 473
Nested fields/dimensions condensed into . Each field/dimension broken out into its own column, with
one column, with one filter option separate column headers and filter options
L]

Allows you to apply custom filters to each field (i.e. label
filters on the Product Category field and value filters on
the Product Sub-Category field)




TABLE LAYOUTS: TABULAR FORM

Tabular Form (non-repeating): Tabular Form (repeating):

= Show in Compact Form
L= | 2 Player (Al hd 2 |Player (All) »/
3 3
— 4 Team ~ | Position - Sum of Salary Sum of Games 4 |Team - | Position ~ | Sum of Salary Sum of Games
= Show in Qutline Form 5 | ©Anaheim Angels  Catcher $2,082,500 341 S5 |©Anaheim Angels  Catcher 2,082,500 341
— 6 | First Baseman $5,250,000 225 5 | Anaheim Angels First Baseman 5,250,000 225
N 7 Outfielder $23,725,000 623 7 | Anaheim Angels  Outfielder 23,725,000 623
- Show in Tabular Form Sl——— Pitcher $27,304,167 1207 2 | Anaheim Angels  Pitcher $37,204,167 1307
L == - E Second Baseman 52,270,000 109 9 | Anaheim Angels  Second Baseman $2,270,000 109
10 Shortstop $1,150,000 146 10| Anaheim Angels  Shortstop $1,150,000 146
11 - - Third Baseman $7,250,000 3 11| Anaheim Angels Third Baseman $7,250,000 83
EEF]E\Et All Item Labels 12 =ZBaltimore Orioles C_atcher $3,830,000 282 17 | ©'Baltimore Orioles  Catcher 43,830,000 282
s First Baseman $8,375,000 396 13 | Baltimore Oricles  First Baseman $8,375,000 396
b Outfielder $22,575,000 531 14| Baltimore Orioles  Outfielder $22,975,000 591
= Pitcher $29,142,500 1478 15| Baltimore Orioles  Pitcher 429,142,500 1478
Do ﬂ‘:'t Repeat Item Labels 26 Shfmsmp $2,850,000 398 16 | Baltimore Orioles  Shortstop $2,850,000 398
17 Third Baseman 56,705,000 197 . n .
18 | S Boston Red Sox Catcher $5,505,000 246 17 | Baltimore Orioles  Third Baseman $6,705,000 197
5 First Basaman $3,250,000 259 15 | ='Boston Red Sox Catcher 45,505,000 246
19 Boston Red Sox First Baseman $3,250,000 259
20 | Boston Red Sox Qutfielder 433,500,000 530
21 Boston Red Sox Pitcher 540,109,000 1355

Use Outline Form when you are manipulating data
within a Pivot, and switch to Tabular form with repeating
labels (and no grand totals or subtotals) if you want to
create a new raw dataset

EXCEL

:MAVEN

I



CONDITIONAL FORMATTING

Insert Page Layout Formulas Data Review  View Developer  Analytics Edge Power Pivot Analyze Design
= cut Calibri 11 A A T == - BEWrapText Currency I::F—l D Normal 2
Ex Copy - . 2] =
Paste ¢ rormatpainter | B 1 U - [Ei- [ O- A~ =[E= &£ EMegedCenter - | §-% 5 | % 3 g:;aio"a'f?;ﬂngs Bad
Clipboard ) Font ] Alignment w Number Il Ii—"l Highlight Cells Rul
Highlight Cells Rules »

H4 S 1.41

A B | c D | E F G Top/Bottom Rules  »
1 |Symbol AAPL
2| Data Bars 3
3 |Row LabelsE‘Open Price High Price Low Price Close Price Daily Volume Volume Trend
4 |8/21/2000 $167.81  $160.37 $166.80 $169.22 143,507 [N I:::I Color Scales s
5 |8/2a4/2009 $170.00 $170.71 $168.27 $169.06 145,331 [
6 |8/25/2000 $169.43  $170.94 $168.13  $169.40 115840 [N Lcon Sets R
7 |8/26/2009 $168.94 $169.55 $166.76 $167.41 108570 N B
8 |8/27/2009 $168.59  $169.57 $164.83  $169.45 160,421 S Bl New Rule..
9 |8/28/2000 $172.06 $172.49 $168.53 $170.05 162,002 S B Clear Rules ,
10 |8/31/2009 $168.09 $168.85 $166.50 $168.21 111,264 N
11 |9/1/2009 $168.02 $170.00 5164.94 516530 167500 [N FE]_Manage Rules
12 |9/2/2009 $164.50 $167.61 $164.11 $165.18 130,123 [
13 [9/3/2009 $166.52 $167.10 $165.00 $166.55 105,036 [N
14 |s/a/2009 $167.20 $170.70 $167.09 $170.31 133,705 N
15 |9/9/2009 $172.72  $174.47 $169.70 $171.14 289,746 .
16 |9/10/2009 $172.03  §173.25 $170.81 $172.56 175,404 N
17 |9/11/2009 $172.96 $173.18 $170.87 $172.16 124,528 [N
18 |9/14/2000 $170.85  $173.90 $170.25 $173.72 115,003 [N
19 9/15/2009 $174.04 $175.65 $173.59 $175.16 152,310 S
20 |3/16/2009 $178.00 $182.75 $177.88 $181.87 269,203 [
21 |s/17/2009 $181.99 $186.79 $181.97 $184.55 280480 S

Q Tell m

Conditional Formatting rules
can be applied to PivotTables just
like normal data ranges

(Home - Conditional Formatting)

Options include:

 Text and Value-based Formats
e DataBars

 Color Scales

* |con Sets

 Formula-Based Rules

[x: MAVEN



SORTING, FILTERING
& GROUPING




SORTING & FILTERING

< dideriosiiazi M ~_ Hit this button (or right-click one of the values)
3 e S . . . .
2 lstate [~ T oo or ot Popuiation to drill into Sorting & Filtering options
%l SortAto Z i 18579040
z 4447100
Al SortZtoA . . . . .
4530182 More Sort Options: Label Filters: Value Filters:
More Sort Options... - s
- P . 4779735 Sort (State) e & | Clear Filte & | Clear Filte
4822023 )
SOT.Optmns Equals... Equals...
I__abel' Filters r L 2724047 (L) Manual (you can drag items to rearrange them) D Mot E |
) 626932 ‘-':-‘Ascendmg (Ato Z) by: Does Not Equal... oes Mot tqual...
Lae e i 655435 | [mme - Begins With... Greater Than...
Search Q 710231 @ Descending (7 1o A) by: Does Mot Begin With... Greater Than Or Equal To...
[Sum of TotalPopuiation |4 B
-[v] (Select All) - 731449 Summary Ends With... Less Than...
A:Ebkﬂamﬂ | = 23756734 Sort State by Sum of Total Population in descending order Does Not End With... Less Than Or Egual To...
-1 Alas]
-[¥ Arizona Manual :;igz:i Contains... Between...
~[¥ Arkansas Selections Does Not Contain... Not Between..
-[¥ california 6329013 Top 10...
colorado 6553255 i Mare Options... I [ oK ] [ Cancel Greater Than...
- Connecticut - 11291081 Greater Than Qr Equal To...
— 2673400 Less Than...
[ 0K ] l Cancel 2752629 Less Than Or Egual To...
= 2915921 Between..,
24 2004 2949131 Not Between...
25 | = California 145060833

EXCEL



GROUPING DATA

A | B | C 5 A , B |
1 |Year 2012 x D@ Copy 1 |Year 2012 x
2 |Employee Name (All) - Format Cells... 2 |Employee Name (All) hd
3 3
4 : Job Title T/ Sum of Base Pay Sum of Overtime Pay ré Refresh 4 : Job Title2 - Joh Title T
5 |Fusion Welder $187,928 54,230 Sort N 5 | = Fusion Welder
6 |Forensic Autopsy Technician $73,899 $530 - 6 | Fusion Welder
7 |Food Service Worker $832,014 $236,773 Filter » 7 | = Forensic Autopsy Technician
8 |Food Service Supervisor $120,515 $12,307 8 N Forensic Autopsy Technician
9 [Firefighter $15,547,896 $3,740,214 v Subtotal "Job Title” 9 | = Food Service Worker
10 |Fire Safety Inspector li $249,959 51,854 10 Food Service Worker
11i Fire Safety Inspector 2 $523,823 $153,958 Expand/Collapse ' 11 | = Food Service Supervisor
12 [Fire Protection Engineer $77,376 50 12 Food Service Supervisor
13 |Fire Fighter Paramedic $3,275,200 $485,124 13 | = Groupl |
14 |Fire Alarm Dispatcher $25,720 S0 14 Firefighter
15 [Fingerprint Technician i 594,278 56,587 N 115]] Fire Safety Inspector li
16 |Fingerprint Technician 3 565,894 5998 - 16 | Fire Safety Inspector 2
17 |Fingerprint Technician 2 $172,595 59,040 x Remove "Job Title” 17 ] Fire Protection Engineer
18 | Feasibility Analyst, Port 589,376 50 18| Fire Fighter Paramedic
19 |Farmer $61,625 S0 '—_1|) Field Settings... 19 Fire Alarm Dispatcher
20 |Fare Inspections Supervisor/Investigator $107,439 S0 PivotTable Options.. 20 | = Fingerprint Technician li
21 |Fare Collections Receiver $228,800 546,455 - 21 Fingerprint Technician li

Hide Field List
Select values that you'd like to group Right-click and A new field is created (“Job Title2")
(in this case fire-related job titles) select Group containing the new group (“Group1”)

Note: Both names can be customized




SLICERS & TIMELINES

H ©- cel_Training AP XCe PivotChart Tools

File Home Insert Page Layout Formulas Data Review View Developer Analytics Edge Power Pivot Design Format ':-';.'-:' Tell me what you want to do

(;t;::tl:ame: Active Field: Expand Field FY 9 [?3 E\' Efx _f:-_‘ @ Jﬂlﬁ

- ) ) Dri Dri Collapse Field Insert Insert Filter Refresh Change Data Clear Move Fields, Items, OLAP Relationships =~ Field Field
[z Options Field Settings pown Up Slicer Timeline [Connections = Source ~ -~ Chart & Sets~  Tools List |Buttons ~
PivotChart Active Field Filte Data Actions Calculations Show/Hide
Insert Slicers or Timelines
State = Year Yx ‘

Alabama

| »

0032004 - Slicers and Timelines work just
like regular report filters, but with
user-friendly interfaces

Alaska

Arizona 2001 2002 2003 2004
Arkansas e ——

California

Colorado

A filter designed
specifically for dates

Connecticut

Basically a prettier
version of a filter!

[x: MAVEN



REPORT FILTER PAGES

A B C D
1 |vear [am -] ] -
T PivotTable Name: Active Field:
2 |Employee Name Search Jo
3 PivotTabled Year .
4710b Title A Sum of Overtime Pay Sum of Other Pay ik 3 A q (PIVOtTabIe TOOlS 9 Analyze)
. ~2011 = Options ~ RFleld Settings
5 |Account Clerk #2012 516,160 526,448
6 |Accountant L2013 50 50 [& Options Show Report Filter Pages (21D |
7 |Accountant | 0 0 IF il h
SiAl:countant i zn 531,8§1 . [ Show Report Filter Pages.. Show all report filter pages of:
9 | Accountant lii 50 9,318 Generate GetPivotData Employee Name -
10: Accountant Intern S0 $6,715 o
11 |Accountant Iv [ Select Multiple Items S0 $29,264
12 | Acupuncturist S0 §1,220
13 |Admin Analyst 3 S0 $5,826
14 | Admin Hearing Examiner S223,205 S0 $2,230 i
15 |Administrative Analyst 54,439,753 $140 518,873
16 |Administrative Analyst | §5,416 S0 50 I oK I I Cancel
17 |Administrative Analyst Ii $118,747 S0 54,247 L —
18 |Administrative Engineer $836,305 S0 $9,742 =
19 | Administrative Services Mgr $183,985 S0 5470

Use the “Show Report Filter Pages” N
option to create new tabs for each value
that a given filter (i.e. Year) can take

Year = 201 Year = 2012




CALCULATED VALUES & FIELDS




SUMMARIZE VALUES BY

|Sum of Order Qua [‘@ Cony '

Format Cells...

Number Format...

@ Refresh
Summarize Values By determines how

I’”"‘%‘i‘w / numbers should be treated when they are rolled
e ey s up or aggregated (sum, count, average, max, etc.)

Show Values As 4 Count

L_") Value Field Settings... Average
PivotTable Options... Max
B show Field List Min

4;3 Product g '

P More Qpions.. Excel will default to “Count Of” if a data

473 column contains blanks or non-numerical
468 values. Typically you will want to change

:gg this field setting to “Sum Of”

465
465
458




SHOW VALUES AS

Sum of Order Quantity

03B Copy

0.2 Format Cells...
0.2
0.2
0.3 |_—é Refresh

0.2

Number Format...

0.3 X Remoye "Sum of Order Quantity”
0.2
0.7 Summarize Values By

0. Zi Show Values As Il

0.2 L_“) Value Field Settings...
0.2

0.2
0.7 H Show Field List
0.23%

0.22%

0.22%

0.22%

0.22%

0.22%

0.22%

0.22%

0.22%

0.21%

PivotTable Options...

No Calculation

% of Grand Total

% of Column Total

% of Row Total

% Of...

% of Parent Row Total
% of Parent Column Total
% of Parent Total...
Difference From...

% Difference From...
Running Total In...

% Running Total In...

Rank Smallest to Largest...

Rank Largest to Smallest...

Index

More Options...

Show Values As options allow you to
apply additional calculations to change

— " the way values are shown, such as the

Percent of a Total or Subtotal, Running
Value, Rank, etc.

In this case, we’re showing Order
Quantity values as % of Column Total,
rather than whole numbers



SHOW VALUES AS - EXAMPLES

In this example we’re summarizing the same Revenue field 6 different ways:

Value % of Total % of Parent % Difference Running Total Rank
(no calculation) Column (genre) (prev. year) (by year) (Large - Small)
J \ J \ J \ )\ )\ J
Y Y Y Y Y Y
Genre |7 Year -7 Revenue Revenue2 Revenue3 Revenued Revenue5 Revenueb
= Action $12,521,476,890 58.01% 100.00%
2010 $2,939,932,519 13.62% 23.48% $2,939,932,519 4
2011 $3,326,029,678 15.41% 26.56% 13.13% $6,265,962,197 1
2012 $3,181,127,752 14.74% 25.41% -4.36% $9,447,089,049 2
2013 $3,074,386,941 14.24% 24.55% -3.36% $12,521,476,890 3
= Adventure $8,130,146,101 37.67% 100.00%
2010 $2,194,189,209 10.17% 26.99% $2,194,189,209 3
2011 $1,180,009,072 5.47% 14.51% -46.22% $3,374,198,281 4
2012 $2,346,041,792 10.87% 28.86% 98.82% $5,720,240,073 2
2013 $2,409,906,028 11.16% 29.64% 2.72% $8,130,146,101 1
= Animation $933,080,437 4.32% 100.00%
2010 $251,501,645 1.17% 26.95% $251,501,645 2
2011 $10,134,754 0.05% 1.09% -95.97% $261,636,399 4
2012 $183,600,836 0.85% 19.68% 1711.60% 5445,237,235 3
2013 $487,843,202 2.26% 52.28% 165.71% $933,080,437 1
Grand Total $21,584,703,428 100.00%



SHOW VALUES AS - INDEX

The Index calculation uses an aggregated weighted average to reveal the impact of one number
within the context of a data set

Revenue Country |-

Genre [¥]  Australia Canada Fenos UK usa Documentaries index very high in France, meaning that a global
Action $843,261,855 $718,355,657 $1,076,178,688 $3,099,974,501 $59,778,470,770 |ncrease |n Docu mentary tlcket prlces wou I d |m pact the
Adventure $274,765,505 $260,123,835 $73,505,978 $2,823,401,894 $26,748,337,472 . . . e g
Animation 563,992,328 §11517.100 $132206052  $3.528,074,076 French film industry significantly more than any other country
Biography $40,246,592 $33,855,526 $53,902,003 $950,806,244 $6,288,688,296
Comedy $77,873,417 $231,856,600 $159,028,092 $980,270,042 $35,675,230,001 \
Crime $2,300,604 $1,882,581 $8,478,574 $366,995,069 $7,485,361,502 Revenue Country -7
Documentary $24,784 $107,581,601 $5,352,503 $435,104,871 Genre | Australia Canada | France | UK USA
Drama $150,361,951 $103,169,476 $360,552,216 $1,236,661,845  $17,705,898,861 Action 1.54 1.25 1.58 0.87 0.99
Family $447,481,433 Adventure 1.09 0.99 0.23 1.72 0.97
Fantasy $123,792,202 $14,564,027 $1,257,990,540 Animation .05 0.00 0.30 0.65 1.03
Horror 549,460,140 5101,747,280 $3,658,281 $195,236,323 $4,729,877,904 Bi h 0.65 0.53 0.70 237 0.93
Musical $184,168,000 lography . . . . .
Mystery $4,717,455 $489,220 $15,523,168 $1,036,780,660 Comedy 0.25 0.71 0.41 0.48 1.05
Crime 0.03 0.03 0.10 0.86 1.04
Documentary 0.00 0.01 18.90 0.18 0.86
Drama 0.92 0.60 1.78 1.16 0.99
Family 0.00 0.00 0.00 0.00 1.09
Fantasy 0.00 10.13 0.00 0.19 0.98
Each Revenue number is converted to an Index representing Horror 116 229 0.07 071 o1
o _ . ] ) Musical 0.00 0.00 0.00 0.00 1.09
it's importance within each column, using the following formula: Mystery 0.53 0.05 141 0.00 107

(Cell Value * Grand Total) / (Row Total * Column Total)



CALCULATED FIELDS

Calculated Fields allow you to create new measures based on existing, numerical fields:

Add

PivotTable Tools

| Name: 1% students Er

Analyze Design ":;-" Tell me what you want to do

Formula: | = 'Student Population'/ 'Tatal Population’ [

inge Data | Clear Select Move  Fields, Items, OLAP Relationships PivotChart HEEE

! a — State
ource ~ - - PivotTable & Sets ~ ools Year i
a Actions Calculated Field.. ';{m

Solve Order...

| E

F | G | H

[ —

' In this case I've added a measure called % Students,
equal to Student Population / Total Population

é Don’t calculate rate metrics (i.e. CTR, CPC) in your raw data, use calculated fields in your
Pivot. This ensures that they calculate properly no matter how your data is rolled up



CALCULATING USING COUNTS

Calculated fields are always based on the SUM of other fields (even if they are shown as a count,
max, average, etc.). But what if you want to make a calculation based on the COUNT of a field?

Ex) Create a field to calculate the
Likes per Post on each date

A

1

Page

A

2 Post Type

3

4 Date of Post T

5
b
7
B
9
10
11
1z
13
14
15
16
17
18
13
20
21
22
23
24

=10/1/2016

=10/2/2016

=10/3/2016

]
Spartan Race X
phota x
Post Copy X

If you missed the #5partanWC16, you misset
Tap that bell then celebrate with a refreshin
The biggest race of the Spartan calendar is h
Your 2016 #5partanWC16 top finishers: Zuza

"Couldn't wait to get home and put it all tog
Hspartanface founder practicing what he pr
Tahoe had one last surprise for us Spartans t
The 26+ mile, 70+ obstacle #5partanWC16 U
This #5partanMedal is ane for the mantle! P
Your tap finishers at this year's #5partanWe:
Your top finishers at this year's #SpartanW:

AROO to all the racers, fans and volunteers 1
As the sun sets on another World Champion:
Cold, mud, ohstacles and snow could not stc
How many Spartans out there are feeling sai
Start the week off strang, and keep it going 2
When Randy Moss,one of the greatest foott

Sum of Likes
2,286
336
218
604
1,128
7,266
534
1,467
2,000
1,743
572
663
287
12,022
749
1,079
B&S
963
2926
5,440

STEP 1: Create a new “Count”
column (=1) in the source data

A B C

Count Page Date of Post Pos
1 Spartan Race 8/30/2016 vi
1 Spartan Race 8/30/2016 Vi
1 Spartan Race 8/30/2016 Vi
1 Spartan Race 8/30/2016 vi
1 Spartan Race 8/30/2016 vi
1 Spartan Race 8/31/2016 vi
1 Spartan Race 8/31/2016 vi
1 Spartan Race 8/31/2016 I
1 Spartan Race 8/31/2016 pt
1 Spartan Race 8/31/2016 vi
1 Spartan Race 8/31/2016 st
1 Spartan Race 8/31/2016 st
1 Spartan Race 8/31/2016 st
1 Spartan Race 8/31/2016 st
1 Spartan Race 8/31/2016 st
1 Spartan Race 9/1/2016 I
1 Spartan Race 9/1/2016 vi
1 Spartan Race 9/1/2016 I
1 Spartan Race 9/1/2016 vi
1 Spartan Race vi

9/1/2016

STEP 2: Create a calculated

field defined as Likes/Count

Insert Calculated Field

Name: Likes/Post

Formula: | = Likes/ Cound

|pate of Post || Post Copy

210/1/2016
If you missed the #SpartanWC16,
Tap that bell then celebrate with :
The biggest race of the Spartan cz
Your 2016 #SpartanWC16 top fini

©10/2/2016
"Couldn't wait to get home and p
#SpartanRace founder practicing
Tahoe had one last surprise for us
The 26+ mile, 70+ obstacle #5part
This #SpartanMedal is one for the
Your top finishers at this year's #5
Your top finishers at this year's #S

-T|Sum of Likes

2,28
33
21
60.

Sum of Likes/Post
572
336
218
604
1,128
1,038

534
1,467
2,000
1,743

EXCEL

MAVEN



CALCULATED ITEMS

Calculated Items allow you to create new dimensions or categories based on existing dimensions:

———— st cacised e Tracre s e |
_ 'S Name: Kids| |z| [M
Analyze Design \/ Tell me what you want to do cormal e [—]
ormula: =t QE|EIE
) J} f - =
({' b X r I Fields: Items:
nge Data Clear Select Move Fields, Items, OLAP Relationships | PivotChart Title | [approved -
Jurce ~ - ~  PivotTable | &Sets~ Tools T B 5 H
i Eie Calculated Field... Colarfant .
Calculated [tem... ;I:;Z;M
PG ol
Solve Order... N [ ]
| ow | 1] =
A List Formulas Vv
a
rg H H
! In this case I've added a new category called “Kids”,

which combines G and PG movie ratings

é DON'T USE CALCULATED ITEMS UNLESS YOU NEED TO; you're usually better off simply
grouping fields or adding new category columns within your source data itself



SOLVE ORDER

Excel_PivotTable_E

Home  Inserl Pat oul  Formulas Dhata e L e e Power Prvol Analyze

i
Sum of Gross Rew =¥ Y |— = [ L7 = {2 e
— : Insert  Incert Filter Refresh Change Data  Clear Select Move  Fields tems, OLAP Relationchips  PivotChart
Lo Freld Settings ¢y, Slicer Timetine Connections = Source * & = PivotTable | 8 Setes
pivotiable Active Figld Group Filter Data Actione Calculated Field..
10 R fe | =Gwg
|
A B C Lb] E F G H I i
1 [Vzar (Al = T List Formulas v Calculated Item Solve Order EE
2 Country USA T 1 Solve order:
1 Language (Al X “%Color' = Color /(Color +Black and White' ) -
4 [Title (aily . i
5
6 Sum of Gross Revenue Rating x L
7 color/B&W -G PG PG-13 R Kids Vi€
8 | Black and White $163,245  SE07,540,245 $1,671,131,048 S$1,016,898017  S607,703,490 7R
9 | Color $6,984,837,347 $36,016,414,525 $72,851,333,140 545 446,884,984 $43,001,251,872 L
10 |‘X.Colo( 100.00% 98.34% 97.76% 97.81% 198.34%| u
a1
If the value in a PivotTable cell is affected by two or more calculated items, the value is
determined by the last formula in the solve order.
ove Down Delete I l Close

If you've defined multiple calculated items, the Solve Order can be used to determine which
calculations to prioritize (value is determined by the last formula in the list)



LIST FORMULAS

PivotTable Tools

Analyze Design ':-';.'-:' Tell me what you want to do

@ @ E‘-) E‘fx Ix I _Cafcufat‘:dField‘ : ' . T

1
ge Data Clear Select Move Fields, ltems, OLAP Relationships | PivotCharl 2 |Solve Order Field Formula
urce ™ < ~  PwotTable & Sets* | Tools 3 | 1 Profit ='Gross Revenue' -Budget
| Actions Calculated Field... 4 3 2 Weighted IMDB Score ='Raw Score’ /'Total Reviews'
- 5} 3 3 Lead Actor Like % ='Lead Actor FB Likes' /'Cast Total FB Likes'
6 -
7 Calculated Item
| H | [ solve Order.. 8 Solve Order Item Formula
"Eji List Formulas H . 9 | 1 '%Color' =Color /(Color +'Black and White' )
1 10| 2 Rating[Kids] =G +PG
N 11
12 |
|-; 13 Note: When a cell is updated by more than one formula,
I 14 | the value is set by the formula with the last solve order.
15 |
16 | To change the solve order for multiple calculated items or fields,
17 on the Options tab, in the Calculations group, click Fields, Items, & Sets, and then click Solve Order.
18

The List Formulas tool produces a new tab summarizing all calculated fields and items
associated with a given Pivot, along with the current solve order



PIVOT CHARTS




PIVOT CHART 101

A PivotChart is simply a chart that is tied to a specific PivotTable; as you adjust filters and
fields in your Pivot, the PivotChart updates dynamically

H ©- : 2014_Excel_Training - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER ADD-INS 1) Select your inOt and Choose PiVOtChart from
L—&' - - [ | I - : - )Jﬂ: 7. H “ ” I13 ”
L) ©7 s 1?2 s ]l 5| either the “Insert” tab or the “Analyze” tab
PivotTable Recommended Table | Pictures Online M & - Recommended . 'PivotChart Map
PivotTables Pictures @+ 7 & My Apps E Charts DL 4 -
Tables Ilustrations Apps m Tours

2) Select a chart type

et O [ ] ¥ - v
r - £ } State ~ | Sum of Population 5
AR Charts um of Population
Alabama 18.579.040 Total
W Fecest == 1 Alaska 2,724,047
'__|J L Arizona 23,756,734 160,000,000
hl cw-« Clustered Column Arkansas 11,291,081 140,000,000
= California 145,060,833 120,000,000
[ Colorado 19,119,442 100,000,000
f’“ ! & Sin-nectlcut 1;,:;8,;;0'ﬁ4. 80,000,000
Ir".“’igil,i;’ij-'li Delaware 2,359,628 60,000,000
. Florida 71.498 418 40,000,000
Georgia 36.623 434 20,000,000
Hawaii 5,226,991 0 I
Idaho 5,850,525 H
lllingis 50,638,814 E
Indiana 25,339,168
-, oo lowa 12,001,311 State ~

3) The PivotChart will be inserted, and dynamically tied to the pivot
(note: you can filter the view using either the pivot table or the chart itself)

EXCEL



PIVOT CHART OPTIONS

The “Analyze” Tab:

H - -

File Home  Insert Page Layout Formulas Data Review View Developer  Analytics Edge Power Pivot Analyze Design Format Tell me what you want to do

Chart Name: | Active Field: _ _ = D [‘5\ - E J:[ILT_
Expand Field =5 ~ o) | A
o2 Y - 8 i 4l T = Lo
5 - - Dri Dri Collapse Field | Insert Insert Filter Refresh Change Data  Clear Move | Fields, Items, ( Field  Field
[Z options Fleld Setings pown  Up Slicer Timeline Connections = Source ~ - Chart 8 Sets~ Tools List Buttons ~
PivotChart Active Field Filter Data Actions Calculations Show/Hide

The “Design” Tab:

H -

File Home Insert Page Layout Formulas Data Review View Developer  Analytics Edge Format @ Tell me what you want to do

£ L]
| -'I- M= *e® |= = rl‘m | I
Add Chart Quick Change --- Switch Row/ Select = Change Move
Element - Layout ~ Colors ~ i Column Data ChartType Chart
Chart Layouts Chart Styles Data Type Location

The “Format” Tab:

Christopher Dutton

,Qr Share

er Share

H ©- X tTable E hart To
File Home  Insert Page Layout Formulas Data Review View Developer  Analytics Edge Power Pivot Analyze Design Format Tell me what you want to do
Chart Area - NN L . - ~  r . Q Shape Fill - AText Fill -
&‘.4 Format Selection Oo0g - . Abc Abc Abe Abe Abe Abc - Z Shape Outline ~ A A A - AText Qutline -
Change J J J
3 Reset to Match Style AL L= - ) - - - - * & Shape Effects - = /A Text Effects = E[;.

Shape
Current Selection Insert Shapes Shape Styles n WordArt Styles ]

Send Backward
Selection Pane

Arrange

[& Align~
Group

Rotate

£ T Height: 3.57"
o3 Width:  7.58"

Size

/Q'. Share




PIVOT CHART LAYOUTS & STYLES

PivotChart Tools
er  Analytics Edge Power Pivot Analyze Format ‘;‘ Tell me what you want to do

12 5

— | Switch Row/ Select Change ove

il Column Data Chart Type Chart
Data Type Location

Element - Layout - Colors -+
Chart Layouts Chart Styles

Chart Layouts & Styles § coommn
allow you to adjust the look . Ny

and feel of a PivotChart, —
including adding elements, ——
changing color palettes, or
applying pre-set templates

Gross Reven

[x: MAVEN



PIVOT CHART FIELD BUTTONS

F | G | H 1 J K

Total Revenue $12,000,000,000

$10,000,000,000

$8,000,000,000

S Revenue

$6,000,000,000
$4,000,000,000
$2,000,000,000

30

\\/

Field Buttons allow you to apply or
adjust filters directly within the chart

2004 2005 2006 2007 2008 2009

H PG HPG-13

2010 2011 2012 2013 2014 2015

=] o

Tl

Field Field
List Buttons -

shot

A
r \
Select PivotChart Tools 2 Analyze 2 Field
Buttons to hide them from the chart (or right

click one of them from the chart itself)

You can format PivotCharts exactly like normal
Excel charts — the only differenceis that
PivotCharts are dynamically tied to a PivotTable



ADDING SLICERS

A Slicer is basically a “prettier” version of a PivotTable filter; it works exactly the same way by
filtering the data you see in your PivotTable and PivotCharts

FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVELOPER
1) Select a PivotTable and choose “Insert
PivotTable Name:  Active Field: Group Selection — F E‘ ) " i ”
: - - ¥ SH IS Slicer” from the “PivotTable Tools” tab
PivotTable3 - Ungroup | ] =
- A Incart Slicers @g ] Insert | Insert Filter Refresh |
EDZOF'“D”S - ‘ 7] Group Fi Slicer flimeline Connections -
PivotTable ] state Filter
[]vear
DPopuIation State -T| Sum of Population State h 4 Sum of Population.
Arizona 23,756,734 Total
California 145,060,833 Alabama il
Colorado 19,119,442 Alask 160,000,000
DC. 3,428,990 aska 140,000,000
Florida 71,498,418 Ari E 120,000,000
Grand Total 262,864,417 100,000,000
Arkansas e
80,000,000
California 60,000,000
Connecticut ZD‘DDD‘DDE . [ ] .
Arizan California Colorad DL Flarida
Delaware
e ¥

2) Select the field(s)
that you want to filter

3) The Slicer will be inserted next to your table, allowing you to
filter on specific values (or combinations, using the CTRL key)

EXCEL



ADDING TIMELINES

A Timeline works just like a Slicer —it’s just formatted to work specifically with Date & Time fields

FILE HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW DEVE . “
1) Select your pivot table and choose “Insert

PivotTable Mame:  Active Field: Group Selection f =l E‘_ Timeline” from the “PivotTable Tools” tab
E — - . ¥l T | &
wotTabled | |Sum( Insert Timelines | 7 P | Ungroup )
- | - _—— ) Inse Insert Filter
L—|E|Dpt|ons - l__'oFu il Group Field % Timeline Connections umofP:gl;Iﬁazli;gs State p 3 Sum of Papulation
PivotTable [¥]¥ear Group Filter 75295386 | Alabama B 40,000,000 fotel
10,216,778 000,
DC. 1515005 | Aaska roeaceo
G ro g | e S
rkansas 40,000,000
oo oo
lD:DDD:DDD . [
Connecticut ¢ aeizon Cafernia Colorade e Frorida
— Delaware state ¥
Year 23
\GEO@QN 2003 -2004 YEARS
Hawaii
Idaho 2001 2002 2003 2004
’ OK ] [ Cancel ] lllinois —
i = ] C
2) Select the date/time 3) The Timeline is inserted, allowing you to filter on specific time frames
field(s) that you want to filter (Note: may need to adjust unit of time (month, year, etc.))
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